This document was created to help schools utilize the web-based applications offered by DMAC Solutions.

Click on the sections below or scroll to the next page to see step-by-step instructions. As always, please contact us if you have any questions!

Contents:
- Settings
- List of Tests
- Creating a New Test
- Filtering Items
- Previewing Items
- Copy/Edit Items
- Printing a Test
- Test Key to TEKScore
- Adding Items in TAG
- TEKS-RS Test in TAG

Click here to watch Online Tutorial
TAG

Log in to DMAC Solutions® at https://www.dmac-solutions.net

*Teacher user names and passwords are automatically generated based on class roster uploads sent to DMAC. The DMAC District/Campus Administrators can create logins for other user roles.

Click on TAG

Admin Settings

▷ The District Administrator has the rights to ALL settings

▷ All other DMAC roles only have rights to:
  • TAG Item Counts
  • TEKS-RS Unit Status
  • Test Share Groups

TAG Item Counts - (accessible to ALL DMAC Roles)

▷ View number of items in TAG

▷ Items designated by:
  • TAG/TEA/TEKS-RS
  • Content Area/Grade Level/SE
**TEKS-RS Unit Status** (accessible to ALL DMAC roles) (must be a subscriber to TEKS-RS for access to questions)

- View the status of TEKS-RS units in DMAC
  - Sorted by Content Area/Grade Level

**Hide Content** -(accessible only to DMAC Admin)

- Check box next to Content type to restrict access to users below the campus level (e.g., Teacher login)

**Test Print Settings** (accessible ONLY to DMAC Admin)

- Manage the default test print settings for the district

- Use this option to modify the default test print settings for the district.
- TAG users will be able to overwrite the defaults temporarily using the settings option on the Tests list.
(District Admin settings continued)

**Test Share Users** (accessible ONLY to DMAC Admin)
Assign automatic access to users for ALL district tests (rights include view and copy but cannot modify or delete)
- > Select District, Campus or Teacher (by campus in drop-down)
- > Select User(s) and click + to add
- > Selected name will appear in window to the right

**Test Share Groups** (accessible to ALL DMAC Roles)
Select **Test Share Groups** to manage groups of users to share tests with:
- > Click 🔄 to view, 📝 to edit and ✗ to delete
- > Click + to create a new group. (Groups may also be created through Share when making a test)
  - Name group and click add
  - Select User(s) and click + to add
  - Click 📐 to save
Reassign User Content (accessible ONLY to DMAC Admin)

- Assign content created by a user no longer in the district to a current user.
- Select TAG Original user
- Select a Current User
- Save

Tests in TAG

- Click Tests from TAG home Screen or white navigation screen

Creating a New Test in TAG

- Click New

- The test Name is the only required field. Keyword(s) and Directions are optional. If the user enters keywords, separate the words or phrases by commas.
Add Items to Test

- From the ‘Add Test Items’ bar click add
- Select the Content Area and course from the drop-down menu
- Select Standard (TEKS or AP)
- To add items in Spanish, select Spanish from the drop-down menu. Otherwise, the default language will be English.
- Click Apply

All of the items in the application for the selected content area and course will appear in the window.

Column Headings

- Click on Column Headings (e.g., SE, Std, Dual SE, etc.) to sort items displayed. Utilize the filter boxes to narrow the search.
- Navigate between pages using the arrows/page numbers in the lower left corner
- The number of items in the search is shown in the lower right hand corner
- Under Related Name, click on a passage to see a preview. To view all items attached to a particular passage, type a part of the title in the related name box and click [ ].

**NOTE:** In this filter, you may type any part of the description (e.g., genre, readability, etc.)
Filtering Items

Select filter from the yellow "Add Test Items" tool bar to narrow your search criteria.

Select by Expectation or by Reporting Category.

Select multiple Primary and Dual Student Expectations from the drop-down menu.

ELAR may select Reading only or Writing only, a specific Genre, and Show Favorite Passages (must have previously chosen under passages).

Only Districts which purchase TEKS-RS may use TEKS-RS Unit filter to access pre-bundled assessment questions.

Check box next to Show Items Assigned and ELPS Standard to access those items.

After completing selections, click apply.
Provide Feedback on Individual Items

- Click to submit feedback about a test item to the DMAC staff. This can include comments about finding an error in a question or answer stem (e.g., misspelling).
- Select Feedback Type
- Enter contact information and feedback
- Click send

Previewing Items

**NOTE:** Make sure pop-up blockers are turned OFF

- Preview individual item information by clicking to the right of each item
- Mouse over the SE or Description to view a pop-up preview
Copy/Edit Items from Add Items Screen

From the Add Test Items Screen, you have the ability to copy an individual item.
- Click **Copy** to the right of the item.
- Rename the item - choose copy. The item will open in a new window to record changes.

In new window:
- **General**
  - Edit General information
  - Add/Edit/Delete **Student Expectations**
- **Standards**
  - Assign TEKS, AP or ELPS to item
- **Question**
  - Click in the question stem box or answer box to access the tool bar to make changes
  - Edit **Question**, **Question Type**, **Correct Response** and **Responses**
- **Save**
Select Test Items

➢ Check the box to the left of the items to preview. To select ALL items on the current page, check the box next to the SE column header.

• **NOTE:** Bolded items indicate they have been previously used on a test the user created (they may be used again)

➢ Items to preview are displayed in a pop-up window

• Un-check any item NOT wanted on the test

• Click **Save check changes**

➢ Click 📋 on the top “Test Bar” to save the items selected. A display message confirms items saved - prompts to continue adding items to the test Y/N.
Icons to the right of items saved on the test offer the following options:

- Edit items (user items only)
- Preview items
- Revise and Replace item

**NOTE:** Revising the item will save it to the test and replace the original item (See Copy Items for further instructions)

- Delete items

To add additional test items choose add from the Test Item Bar (refer to Add Items on page 5)

Choose multi-delete from the yellow Test Item bar to delete multiple items from your test by checking the box next to the item for deletion - choose Delete

Each item may also be previewed from this screen.
To re-number/reorder test items, choose 🔄 from the Test Item Bar.

Manually change the numbers in the boxes OR Grab the dots to the left of the boxes with your mouse and drag/drop to preferred location.

Click Save in upper Test Bar to change the order of the items.

Choose 🔄 from the Test Item Bar to return to the original order of the items.

To change the order of passages (ELAR) and all related items choose Reorder Related 🔄 from the Test Item Bar. This will open a pop-up window.

1. Use the dots to the left of the number to drag/drop a passage and all related items to new order.
2. Use the preview icon 📒 to the right to review the passage.
3. Save.
Settings

- Customize the print settings for a test by clicking on the **Settings** icon located at the top right.
- Choose applicable print settings for this test.
- **Note:** Print settings will reset when browser is closed.

Preview Test

- Preview complete test in a pop-up window (not formatted here).
Test Key

- View/print Test Key ☑

Share a Test

Share the test with specific users or groups of users by choosing **Share 📚 User** -

- Choose the Available **Users Role** (District, Campus, Teacher) and **Campus**

- **NOTE:** This person(s) will not be allowed to edit this test - they can only view/copy it

- Click +

- Name will appear in window to the right

**Group (groups are maintained/edited in Admin - Test Share Groups)** Repeat instructions above for User

- After choosing the individuals to share with - choose 📚 to name the group

- If a group already exists
  - Choose the radio button for Group at the top left of the screen
  - The list of groups will appear in the window on the left
  - Choose the group name
  - Click +

**Note:** Tests must be shared with users in your district who create the test key in TEKScore

**Note:** Click here to name the selections as a group
Printing a Test

> Click Print

> Choose the **word** or **clipboard** icons to copy the test. This allows a test to be pasted in Microsoft Word® or another word processor.

- The **word** icon is the preferred method to move a test over to a word processor.

- The **clipboard** option can be used. Click **clipboard**, select **Allow access** if a pop-up window appears. Paste the document into the word processor before printing.

> Click **help** for additional Print Test tips OR call the DMAC Help Desk for additional options (1.866.988.6777)

**Note:** Be sure to select the print preferences in settings prior to printing a test.

Helpful Test Formatting Tips for PC

After inserting your test into a word processing application (i.e., Microsoft Word)

> View > **Print Layout**

> Page Layout > Margins > **Narrow**

> Select **CTRL + A** to highlight test; from ‘Home’ screen change font or size

> Starting at the beginning of your test click above items; Insert > **Page Break** to move items to another page

> Save test as a Word Document (.doc or .docx) or .pdf
TEKScore

**NOTE:** User must have rights to create TEKScore keys

- This feature opens directly into the TEKScore application in a new window. With proper authorization, the user can complete the **Test Key Header, Save** and make any additions/changes to the Test Key from what has been copied from TAG.

Additional Test Bar Icons:

- + begin a New test
- □ returns to List of Tests page
- ? provides additional information
List of Tests Icons

- Click **New** (+) to create a new test.
- Select the **Refresh** (⟳) to reset the test list to its original order (clearing all filters).
- Click the **Settings** (⚙️) to establish print settings for your test.
- Select **Help** (?) for tips about the features on the List of tests page.
- Column header filters test by **Name**, **Content Area**, **Course**, **Keyword(s)**, **Test Type**, **Items** or **Test number**.

- Test type definitions:
  - User - test created by Users (your DMAC Login)
  - District - test shared with you by someone in your district
  - TEA - released STAAR/TAKS test

Note: Users can create custom tests in TAG or select from a library of pre-bundled assessments including TEA released tests.

### Individual Test Icons

- **Edit** icon is used to **modify existing tests**. A user must be authorized to edit a test.
- Preview the test by clicking the **preview** icon.
- **Print** icon is used to print the test. Refer to page 15 for printing instructions.
- **Key** is used to view/print the key for that test.
- Click the **copy** icon to copy selected test. Name the test. It will open automatically to be edited modified.
- **Merge** icon is used to merge multiple tests together. See instructions on next page.
- **TEKScore Test Key** button is used to create/open the TAG test key directly in TEKScore.
- **Delete** icon is used to delete the test. (Note: District Administrators can delete tests for their district). After deleting, the test will no longer be available in the List of Tests.
Merge Test

> Select **Test from list**

> Click on **Merge**

> Choose **Content Area and Course**

> Select **Test Type** and **Merge Style**

> Click **Search** to see available tests based on your criteria

> Select from available Tests test to merge

> Click **merge**

> Name new test and click **add**

> Merged Tests will open in new window

**NOTE:** Only allowed to merge one test at a time.
Creating a TEKS-RS Test in TAG

Creating a New TEKS-RS Test in TAG

> Click **New** 
> Type Name of Test
> Click + add on the yellow Add Test Item bar
> Select **Content Area** and **Course** from Pop-up box
> Click **Apply**
> Click on + on the yellow Add Test Item bar
> Select the **TEKS-RS Unit** from drop-down
> Click **Apply**

**Note:** Only the items assigned to that unit will appear.
Check the items that you want to add to test.

Click Save.

When prompted, select “no” to continue adding more items. (unless you are merging units or wish to include additional items - then select “yes”)

Reorder or renumber as previously stated

Complete editing and printing using icons in top Test Bar
Items in TAG

Once you’ve entered the TAG application, choose Items. After choosing the content/course information, a list of items will appear.

Adding Items in TAG

> Click on **New** to add a new item
Items

The user will complete the General, Standards and Question information for the item. All required fields are noted with an asterisk.

**Note:** The Description field is required but will automatically populate with a portion of the question when creating an item. Only make an entry if the user prefers to use another description for the item.

- Complete the General information fields that are required, plus any other fields. Click Save.
- To select TEKS, AP or ELPS Standards click add. 
  - A list of SEs for the selected Content Area and Course will appear. You may also choose to Dual Code the SE. Select SE’s and click apply.
  - Click edit to change or update the SE or delete to remove it.
- If the item is related to a passage or graphic choose the radio button, then select the passage or graphic from the dropdown.
- Click inside the box to enter the Question and Responses.
- Enter the Question type and Correct Response from the dropdown menus.
- To Share the item, select Share.
  - **Note:** This option is only available after the item has been saved.
- Select Save to save all changes for the item. **NOTE:** Save often so you don’t lose your work!
- Preview will not be available until the user creates an item and saves the information.
- Select New to add an additional item to the bank.
- Select List to return to the List of Items page.
- Select Help for tips about the features for the Add new item page.
Editing Text & Uploading Graphics

When the user clicks in the Question or Responses box, a text editor box will appear with features used to customize the item.

- View full screen mode for item entry.
- Insert Graphic from existing library
- Upload a graphic that has been saved on the computer.
  - IMPORTANT: The graphic must be saved as a .jpg or .gif. Insert graphic(s) in size they will be used in the item (max size 675 pixels x 875 pixels). Black and white and grayscale graphics print with the best quality.

  - Locate the graphic by clicking Choose File.
  - To add the graphic to the library for future use, check the reuse box. The user will be prompted to add the additional information needed for the graphics library.
  - Click insert. The graphic will be placed in the question or response box.

- Be sure to save the item. The preview icon will be available for all saved items.
- Click list to return to List of Items page
Passages in TAG

From the **Home Screen**, choose **Passages**. After choosing the content/course information, a list of passages will appear.

> + **Add New** Passage
> 🔄 **Filter** for other grade level passages
> 🔄 **Refresh** the List of Passages screen to original list (clears all filters)

> 🔄 **Additional information**
> > Columns are sortable by clicking the headings. Columns may also be filtered.
> > Click ✔️ gray check beside a passage to add to User’s Favorites List. The check will become green (✅).
> > Passage list icons
> >   - 📝 **Edit** a passage created by the user
> >   - 🎨 **Preview** passage
> >   - 🎨 **Preview** related items
> >   - 📝 **Copy** passage to modify
> >   - ✗ **Delete** a passage created by the user
Adding Passages in TAG

- Click **New**

- Name passage and complete other information

- Enter passage. When the user clicks in the passage box, a text editor box will appear. This has features to allow the user to customize the passage. (See Editing Text and Uploading Graphics)

- ![Save](image)

- ![Add New](image) passage

- ![Return to List of Tests](image)